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Before using this information and the product it supports, read the information in “Notices”. 

This edition applies to version 8, release 3 of IBM® Maximo Manage and to all subsequent  releases and 
modifications until otherwise indicated in new editions. 
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Overview 

Maximo Manage 8.3 uses Business Intelligence and Reporting Tool (BIRT) version 4.8.0. 

If you want to create your own reports or modify existing reports, you must set up a report development 

environment. To set up a Maximo Manage report development environment and configure BIRT 4.8, complete 

the following tasks: 

• Install the prerequisite 8.0 version of the IBM SDK

• Download and install BIRT 4.8

• Add Maximo Manage libraries, reports, script libraries, template files, and JAR files to your report

development environment

• Configure BIRT for Maximo Manage reports

• Configure access to BIRT

• Create a Maximo Manage project in BIRT

After you create or modify reports, you can import them from your development environment into Maximo 

Manage. 

Prerequisites 

A copy of IBM SDK or JRE 8.0 must be installed on the client machine before installing the BIRT Designer. 

Make sure you use either a 32-bit or 64-bit SDK that corresponds to a 32-bit or 64-bit Eclipse package. 

Complete the following steps to download the IBM Development Package for Eclipse/Java SDK: 

1. To download the Java SDK, log in to the following website with your IBM account credentials:

https://www.ibm.com/support/pages/java-sdk-downloads-eclipse

2. Download the appropriate file for your operating system. For example, if you have a 64-bit Windows

operating system, download the IBM_DevelopmentPackage_for_Eclipse_Win_X86_64_6.7.5.zip

file.

3. Install the Java SDK.

Downloading and installing BIRT Report Designer 4.8 

To download and install BIRT 4.8 complete the following steps: 

1. To download BIRT 4.8, go to the following web site:

https://projects.eclipse.org/projects/birt/releases/4.8.0

2. Click Download.

3. Select the folder for BIRT 4.8.

4. Download the birt-report-designer-all-in-one-4.8.0 compressed file for your operating system.

5. Extract the compressed file to a local directory with a name does not include any spaces, for example 
C:\birt_480.

https://www.ibm.com/support/pages/java-sdk-downloads-eclipse
https://projects.eclipse.org/projects/birt/releases/4.8.0
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Copying files from Maximo Manage to the development environment 

Some files in your Maximo Manage deployment are required for BIRT report development. You must copy the 

following files and folders to your local report development environment: 

• Libraries 

The libraries directory contains library, resource, and property files that are required to support the 

report design files. 

• Reports 

The reports directory contains content for the standard reports that are delivered with Maximo Manage. 

• Script Libraries 

The script library contains script library classes and the mxreportdatasources.properties file used by 

BIRT Designer tool to connect to databases. 

• Templates 

Twelve template files are used as starting point in creating report design files. When creating any 

report, you must start with one of the templates because they contain the required scripted data 

source and library files needed for the integration. 

• JAR file for the JDBC driver for your database 

There are two options for adding the files that you need for report development: 

• Copy the files from an existing Maximo Manage instance to your development environment. 

• Set up Maximo Manage on a local machine by storing a Maximo Manage image in an external registry, 

retrieving the contents of the image, and instantiating it by using a container engine, such as Docker. 

Then, copy the files from the local Maximo Manage image to your development environment.  
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Option 1: Copy files from an existing Maximo Manage deployment to your development 

environment 

Prerequisite 

Before you begin the following procedure, install the rsync command line utility, which you can use to transfer 

files from Maximo Manage to your development environment. For information about transferring files, see 

Transferring Files In and Out of Containers in OpenShift. 

Procedure 

Complete the following steps to copy files from an existing Maximo Manage deployment to your report 

development environment: 

1. To get the required access token for Maximo Manage, log in to the OpenShift Platform Console as an 

administrator and complete the following steps: 

a. From the account menu, select Copy login command. 

 
b. Select Display Token. 

c. Copy the oc login command in the Log in with this token field: 

 

 

2. In a Linux shell in your BIRT development environment, run the command that you copied for the 

login token. 

https://cloud.redhat.com/blog/transferring-files-in-and-out-of-containers-in-openshift-part-1-manually-copying-files
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3. To go to the Maximo Manage project, run the following command in the Linux shell: 

oc project <name of the Maximo Manage project> 

For example,  

oc project mas-build-manage 

4. To find the name for your Maximo Manage admin pod, open a Linux shell and enter the following 

command: 

oc get pods 

The admin pod is the pod that includes maxinst in the name. Make note of the full pod name 

because you specify this pod in step 5. 

5. To copy the contents of the libraries, reports, scriptlibrary, and templates folders to the report 

development environment, run the following command: 

oc rsync <admin pod name for your Maximo Manage 

instance>/opt/IBM/SMP/maximo/reports/birt . 

The period character copies the files to Linux home directory in your local environment. You can also 

enter a specific file location instead of using the period character. 

6. To copy the JDBC driver for your database to the report development environment, run the following 

command: 

oc rsync <admin pod name for your Maximo Manage 

instance>/opt/IBM/SMP/maximo/applications/maximo/lib/<your_jdbc.jar> . 

• For Oracle, specify the oraclethin.jar file. 

• For SQL Server, specify the sqljdbc.jar file. 

• For DB2, specify the db2jcc.jar and db2jcc_license_cu.jar file. 

The period at the end of the command copies the file to the Linux home directory. You can specify 

another location if you prefer. 

After you complete these steps, go to Configuring BIRT 4.8 for Maximo Manage reports. 

Option 2: Set up a local Maximo Manage instance and copy files to your development 

environment 

If you do not have administrator access to an existing Maximo Manage instance, you can deploy a local 

instance of Maximo Manage. You can configure Maximo Manage to store images in an external registry. Then, 

you can retrieve the administrative image and instantiate it in a container engine, such as Docker. 

To use this option, you must first install a container engine, such as Docker. 

For information about storing Maximo Manage image in an external registry, see Storing Maximo Manage 

images in an external registry. 

For information about instantiating a Maximo Manage administrative image in a container engine such as 

Docker, see Retrieving the contents of an administrative image. 

After you set up the local Maximo Manage instance, you can use the steps in the preceding section to copy the 

files from that instance to your report development environment. 

https://www.ibm.com/docs/en/maximo-manage/8.3.0?topic=deploy-storing-images-in-external-registry
https://www.ibm.com/docs/en/maximo-manage/8.3.0?topic=deploy-storing-images-in-external-registry
https://www.ibm.com/docs/en/maximo-manage/8.3.0?topic=application-retrieving-administrative-images
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Configuring BIRT 4.8 for Maximo Manage reports 

Complete the following steps to configure BIRT for Maximo Manage reports: 

1. For the script library, copy the folder that contains the script classes from the temporary location 

where you stored it to Eclipse, as shown in the following example: 

Copy the classes folder from 

<temporary_directory>/reports/birt/scriptlibrary/classes 

to 

<birt_480>/eclipse/plugins/org.eclipse.birt.report.viewer_4.8.0.v201806261756/birt/WEB-INF/ 

2. For the database driver, copy the database driver file from the temporary location where you stored 

it to the following location in Eclipse: 

<birt_480>/eclipse/plugins/org.eclipse.birt.report.viewer_4.8.0.v201806261756/birt/WEB-

INF/lib 

3. Open the database jar file you copied and extract the contents of the jar file to 

<birt_480>/eclipse/plugins/org.eclipse.birt.report.viewer_4.8.0.v201806261756/birt/WEB- 

INF/classes 

4. The mxreportdatasources.properties file defines the connection from the BIRT designer to the 

Manage database. The file is in the following Eclipse directory: 

<birt480>/eclipse/plugins/org.eclipse.birt.report.viewer_4.8.0.v201806261756/birt/WEB-

INF/classes 

Edit the file to provide values for the following parameters for your database:  

• Database URL 

• Database driver 

• Database username 

• Password schema owner 

The following example is configured with sample values for a DB2 database in the outlined area. 

#<DataSourceName>.<propertyName>=value  

# driver for ORACLE 

# oracle.jdbc.OracleDriver 

# sample url for ORACLE 

#   jdbc:oracle:thin:@<HOST>:<PORT>:<SID>  

# sample schemaowner for ORACLE 

# maximo 

 

# driver for SQLServer 

#   com.microsoft.sqlserver.jdbc.SQLServerDriver  

# sample url for SQLServer 

#      jdbc:sqlserver://hostname:port;databaseName=dbname;integratedSecurity=false;  

# sample schemaowner for SQLServer 

# dbo 

 

# driver for DB2 

# com.ibm.db2.jcc.DB2Driver  

# sample url for DB2 

# jdbc:db2://localhost:50000/dbalias  

# sample schemaowner for DB2 

# maximo 

maximoDataSource.url= jdbc:db2://IBM-A5:50000/DB2A 

maximoDataSource.driver=com.ibm.db2.jcc.DB2Driver  

maximoDataSource.username=henryl  

maximoDataSource.password=henryl  

maximoDataSource.schemaowner=maximo 
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Accessing BIRT 

1. Create a shortcut to BIRT Designer 48 from eclipse.exe. 

2. Update the target for the shortcut to include your JDK 1.8 path as shown in the following example: 

C:/birt_480/eclipse/eclipse.exe -vm "C:/ibm/Java80/jre/bin/javaw.exe" -vmargs -Xmx512m 

3. Launch BIRT Designer from your new shortcut. 

4. Select an applicable workspace location for your environment. Check Use this as default and click OK 

to open Eclipse. 

Creating a Maximo Manage project 

The following instructions explain how to create a new project. If you have an existing project file in your report 

libraries, you can click File > Import and import the existing file instead of creating a new one.  

1. In Eclipse, select File > New > Project. 

 

2. In the New Project window, expand Business Intelligence and Reporting Tools, select Report 

Project, and click Next. 
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3. In the New Report Project window, enter a project name and click Finish. 

 

4. In the Open Associated Perspective window, click Open Perspective. 
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5. To confirm that the import was successful,  on the Navigator tab, open a report. 
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6. To add libraries to BIRT, complete the following steps: 

a. From the Window menu in Eclipse, select Preferences. 

b. Expand Report Design and select Resource. 

c. Click File System. 

d. To specify the location of the libraries, navigate to the libraries folder in your report 

development environment, as shown in the following example: 

 

e. Click Apply. 
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7. To add templates to BIRT, complete the following steps: 

a. In the Report Design section, select Template. 

b. In the Template folder field, specify the location of the templates in your report development 

environment, as shown in the following example: 

 

c. Click Apply. 

8. Exit Eclipse and then restart it. 

Importing reports into Maximo Manage 

After you create reports, you can import the reports into Maximo Manage. 

For information about importing reports, see Importing reports in the Maximo Manage documentation in IBM 

Docs. 

  

https://www.ibm.com/docs/en/maximo-manage/8.3.0?topic=reports-importing
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Notices 

 
This information was developed for products and services offered in the U.S.A. 

IBM may not offer the products, services, or features discussed in this document in other countries. 

Consult your local IBM representative for information about the products and services currently 

available in your area. Any reference to an IBM product, program, or service is not intended to state or 

imply that only that IBM product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be used instead. 

However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, 

program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You can 

send license inquiries, in writing, to: 

IBM Director of 

Licensing IBM 

Corporation 

North Castle Drive 

Armonk, NY 10504-

1785 U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send inquiries, in writing, to: 

Intellectual Property Licensing 

Legal and Intellectual Property Law 

IBM Japan, Ltd. 
19-21, Nihonbashi-Hakozakicho, Chuo-ku 
Tokyo 103-8510, Japan 

The following paragraph does not apply to the United Kingdom or any other country where such 

provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 

THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE. Some 

states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this 

statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically  

made to the information herein; these changes will be incorporated in new editions of the publication. 

IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 

any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 

of the materials for this IBM product and use of those Web sites is at your own risk. 
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IBM may use or distribute any of the information you supply in any way it believes appropriate without 

incurring any obligation to you. 

Licensees of this program who desire to have information about it for the purpose of enabling: (i) the 

exchange of information between independently created programs and other programs (including this 

one) and (ii) the mutual use of the information which has been exchanged, should contact: 

IBM 

Corporation 

2Z4A/101 
11400 Burnet Road 

Austin, TX 

78758 U.S.A. 

Such information may be available, subject to appropriate terms and conditions, including in some 

cases, payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided 

by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or 

any equivalent agreement between us. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 

published announcements, or other publicly available sources. IBM has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM 

products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 

those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 

notice and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 

products. All these names are fictitious and any similarity to the names and addresses used by an actual 

business enterprise is entirely coincidental. 

1. Privacy Policy Considerations 

IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies 

or other technologies to collect product usage information, to help improve the end user experience, to 

tailor interactions with the end user or for other purposes. In many cases no personally identifiable 

information is collected by the Software Offerings. Some of our Software Offerings can help enable you 

to collect personally identifiable information. If this Software Offering uses cookies to collect personally 

identifiable information, specific information about this offering’s use of cookies is set forth below. 

This Software Offering does not use cookies or other technologies to collect personally identifiable 

information. 

If the configurations deployed for this Software Offering provide you as customer the ability to collect 

personally identifiable information from end users via cookies and other technologies, you should seek 

your own legal advice about any laws applicable to such data collection, including any requirements for 

notice and consent. 

For more information about the use of various technologies, including cookies, for these purposes, see 

IBM’s Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at 

www.ibm.com/privacy/details in the section entitled “Cookies, Web Beacons and Other Technologies” 

and the "IBM Software Products and Software-as-a-Service Privacy Statement" at 

www.ibm.com/software/info/product-privacy/. 

 

http://www.ibm.com/privacy
http://www.ibm.com/privacy/details
http://www.ibm.com/software/info/product-privacy/
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2. Trademarks 

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International 

Business Machines Corp., registered in many jurisdictions worldwide. 

Other product and service names might be trademarks of IBM or other companies. A current list of IBM 

trademarks is available on the Web at “Copyright and trademark information” at 

www.ibm.com/legal/copytrade.shtml. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or 

its affiliates. 

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 

United States, other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

http://www.ibm.com/legal/copytrade.shtml

